
Version 1.0

Using your Knowledge Base 
Data to Deliver Better 
Experiences

2021 KB User Group Meeting

Kedar Joyner  |  UX/UI Designer  |  July 28, 2021

University of Wisconsin-Madison



Table of Contents

01 Intro

02 Definitions

03 Page View Data

04 Search Log Data



UX/UI Designer

Kedar Joyner
UX/UI Designer with 6+ years of experience in the 
tech industry.  I specialize in interface design within 
the Division of Information Technology where I 
help design enterprise applications for campus. 

Software Design 90%

User Research 83%

Illustration 75%

Web Development 60%



Definitions

Page View Data

Shows the number of time each individual document within 
a KB Group has been viewed over a given time period. 

● Log into your KB Group
● Navigate to the “Stats” tab 
● Click on “Doc Views by Doc”  in left hand menu



How can Page View data help me? 

● Provides a high-level overview of audience behavior and what 

information they might be most interested in (i.e. informational, 

events, how-tos, etc.)

● Can also surface potential problems with your site. High page 

views do not always mean you are  reaching a broad audience or 

that users are able to locate the information they need. 

● Can be compared with search log data to understand whether 

people are finding answers/docs to popular searches. 



Definitions

Search Log Data

Allows admins to browse through all successful (green text) 
and failed (red text) customer searches over a given time 
period.

● Log into your KB Group
● Navigate to the “Stats” tab 
● Click on “Search Log” in left hand menu 



How can Search Log data help me? 

● Failed searches may help you identify the need to create new 

documents,  revise existing documents, or create 

new/expanded keywords and synonyms. 

● Additionally, failed searches can often include the most 

commonly misspelled words which can be added as synonyms 

to a document. 

● Search data should help inform document titles, keywords, 

meta descriptions, and inform what displays on the homepage.



Page View Data
Let’s learn how to export this data, strategies for 
analyzing the information, and steps for taking action on 
what you discover from your analysis. 



Export Page View Data 
1. Log into KB Admin 

2. Choose KB Group

3. Click on “Stats” tab

4. Click on “Doc Views by Doc” from side menu

5. Increase limit to equal more than the total number of results

6. Export CSVs from the last 2 years (minimum 1 year)



Step 1
Combine both CSV files into one 

ring that rules them all

Step 2
Delete all columns except for Title 

and Total



Step 3
Select a cell where you want the 

merged data to appear

Step 4
Go to Data > Consolidate and select “Sum” as 

the function, check “Top Row”, and select 
columns A and B



Step 5
Copy the output into a new tab and sort 
the data from smallest to largest in the 

Total column

Done! 🎉
Now you’re seeing which KB Documents have 

the highest page views over a 2 year time 
period. You’re ready to analyze!



Content Modules
Ignore any page views that are given to 

Content Module documents. Every time a user 

visits a page with a content module, it’s 

recorded as a page view for that particular 

document.

For documents with high page views, check if 

they are content module first by going to 

KB Admin > Site Prefs > Content modules 

Example
KB User Group Meeting  has 48,653 page 

views, but it’s a Content Module so that 

number is inflated.



“Linked From” Documents

Documents that are linked from other 

documents may have inflated page views 

because they encourage more traffic. However, 

this does not mean people find the information 

on these documents useful.

If your document is being referenced in other 

documents, the option to view “Linked from” will 

appear at the bottom of the doc in the admin.

Example
This document has 30, 764 views and is 

linked from 74 other docs, but it has 591 

helpful votes and 437 unhelpful



Analyze the Data
Start small and look at the top 25-50 most viewed documents. 

Questions to Ask Notes

Does anything look odd or unexpected? Look for things that make you think, “Oh, interesting!” to 
investigate further.

Does your KB homepage reflect the documents that people are 
viewing the most? 

Helpful to compare this data with your existing homepage to see if 
popular documents are missing from view or need to be placed 
higher on the page. 

Are these documents easy to find? And is there anything 
confusing about them? 

If they’re not referenced on the homepage, should they be? Are 
they easily searchable? Do they contain relevant keywords and 
synonyms to improve searchability?

Can these documents be grouped together in logical categories 
(if not already) that might help users find the information they 
need more quickly? 

You may find that based on what you find, your homepage could 
be improved by improving navigation and/or groupings of content 
under categories that make sense to your audience. Consider a 
card sort exercise to determine these categories.

https://www.usability.gov/how-to-and-tools/methods/card-sorting.html


Card Sorting

Card sorting is a method used to help 

design or evaluate the information 

architecture of a site.

In a card sorting session, participants 

organize topics into categories that make 

sense to them and they may also help you 

label these groups.

https://www.usability.gov/what-and-why/information-architecture.html
https://www.usability.gov/what-and-why/information-architecture.html


Example
For the KB User’s Guide we noticed 
based on the top page views, that 
content on the homepage was organized 
from least important to most important, 
and we want to flip this order. 

The first 3 Top Docs are also content 
modules, so they likely aren’t top docs in 
the truest sense. 

Sidebar content also does not contain  
the themes we found in the top page 
views and searches.



Search Log Data
Let’s learn how to export Search Log data and 
filter out pesky bot traffic to have a more 
accurate picture of what your users are searching 
for on your KB site.



Why don’t we just view 
the “Top Searches” log?

● Can only view one year of data at a time 

● Doesn’t filter out bot traffic. Discovered 

that roughly half of searches originated 

from non-human traffic or untrustworthy 

IP addresses 

● Still provides a useful picture, but not as 

accurate



Export Search Log Data 
1. Log into KB Admin 

2. Choose KB Group

3. Click on “Stats” tab

4. Click on “Search Log” from side menu

5. Filter log data by  “Successful” or “Failed” respectively

6. Click on the “Export All” button

7. Export CSVs from the last 2 years (minimum 1 year)

8. Combine both files into one



Remove Duplicates

Step 1

Often bots will make the same search multiple 

times at once or within seconds/minutes of each 

other. 

So we’ll remove duplicate entries that contain the 

search term and occur at the same time. 

Note: It’s also helpful at this time to remove cells that are blank or contain Excel errors.



Remove Special Characters

Step 2

Bots will often make SQL injections (e.g. 

“A=0”) and special characters (e.g. “/”, “[0]”, 

“!+{}”) into their searches. 

In the upcoming steps, we’ll remove all 

searches that contain special characters to 

help filter out bot traffic and clean the data as 

best we can. 



Step 3
In your Excel file click on “Excel” in the top 

menu > Preferences > View and check 
“Developer tab”

Step 4
Now click on the “Developer” tab > Visual 

Basic > and then you will see the VB editor



Step 5
Insert a module from the Insert menu. Copy the code below and 

paste it into the module. Click save, and now your function is 

ready to be used! 

https://www.google.com/url?q=https://www.exceltip.com/excel-text-formulas/how-to-find-any-special-characters-in-a-string-in-excel.html&sa=D&source=editors&ust=1627354557796000&usg=AOvVaw10BQHIxUyqowTYd_wYKz2x


Step 6
Insert a new column in your primary 

workbook next to the “Search Term” column

Step 7
Write the below in Cell 2 in the new 

column you just created. 



Step 8
Double click the bottom right corner of Cell 2 to apply the 

function to the entire row. It will display TRUE for strings that 

contain a special character and FALSE for those that do not.



Step 9
Use the “Conditional Formatting” feature to 

highlight a cell red if it’s equal to the word “TRUE”

Step 10
All cells that contain “TRUE” should now be 

highlighted red. 



Step 11
Select your entire spreadsheet and sort your 

spreadsheet based on the highlighted cells. 

Step 12
Select all of the cells highlighted 

red and delete. 



10,404
I got rid of 10,404 rows after cleaning my Search Log data. If you were to 

check every IP address, even more would be removed but that’s not an 

efficient use of time with thousands of results. With this method, we at 
least have a more accurate data set than we did before. 

Next, we’ll walk through how to find all of the unique search values and 

count how many times these words were searched. 

https://martechwithme.com/how-to-find-the-frequency-of-a-list-of-words-in-a-column-in-google-sheets/


Count the Unique 
Search Terms
Step 13
Create a new tab in our spreadsheet and 

copy/paste only the “Search Term” column. 



Step 14
Because there are multiples of the same 

search terms, we want to create a list of 

each search term that contains only one of 

each. We’ll use the “Unique” formula like 

shown here:

Add the formula to the first cell in 

the second column.

Press enter to apply the function to 

the entire row.



Counting the 
Occurences
Step 15
Now that we have a unique set of Search 

Terms, we want to count how many times 

each term occurs. Starting by creating a 

new column titled “Count”



Step 16
Use Excel’s “=COUNTIF” function to count how many times each 

unique search term occurs in Column A.



Step 16
Copy column B and C and paste into a new tab, but we want to “Paste 

Special” and then choose “Value”.  We want static version of the  

dataset, otherwise the embedded formula will try to recalculate the 

data when we sort the sheet leading to errors. 



Step 17
Sort the data based on the value of the Count 

column from largest to smallest. 

Step 18 🎉
Review your file and remove anything that’s 

clearly spam (i.e. “???”), still contains special 

characters, or empty cells. Now you have a more 

accurate dataset to work with! 



Analyze the Data
Start small and look at the top 50 - 100 searches. Look for those 

“Oh, interesting!” moments. 

Questions to Ask Notes

Do the top search terms also match the top documents? If they don’t, you may need to update the site to show those 
things in order to help users find what they’re looking for most.

When looking at failed searches, what are keywords people are 
searching for? Do these keywords need to be added and/or do 
new documents need to be created? 

Looking at failed searches can help you you find any keywords, 
synonyms, or documents that might need to be added/updated.

Also for failed searches, are there any common misspellings? Consider adding these misspellings as synonyms to your 
documents(s) so that users still see related results.

Can you group these search terms into common themes? What 
patterns do you notice in these common groupings? 

This may help you understand how users think about the content 
for your particular service/group, and you can use this information 
to organize content in a way that they related to.



Example
For the KB User’s Guide we grouped 
searches into the following categories: 

● How to design with the KB
● Understanding what thing are
● Content sharing
● Notifications
● KB meeting information
● Authoring
● Training 
● Batch features/migrations
● Searching for university-wide 

information, rather than just KB



Questions?

Contact
kedar.joyner@wisc.edu

“A user interface is like a joke. If you have to explain it, 
it’s not that good.” - Martin LeBlanc 


